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Author Submission Guidelines 
 
Introduction 
 
Counselling, Psychotherapy and Health (CPH Journal) is an international, 
interdisciplinary, peer-reviewed, open-access, on-line journal devoted to providing 
leadership in counselling, psychotherapy, and health related research, inquiry, 
professional, and scholarly debate. CPH Journal is the official research journal of the 
Australian Counselling Association (ACA). The international Editorial Board is made up 
of a wide range of academics, practitioners, researchers, senior honorary advisors, and 
includes postgraduate student representation. The Board represents counselling, 
psychotherapy and health related disciplines in a way that reflects diversity, and 
respects time-honored editorial autonomy, independence, and non-sectarian views. 
 
Our Guiding Values 
 
The Editorial Board is committed to an equitable reviewing approach that offers 
assistance to writers and researchers through a systematic and supportive review of 
material. Our goal is to encourage writers and when appropriate to recommend 
publication. Articles published in CPH Journal must in some way address, or be seen to 
complement, our guiding values. These values form part of the criteria for editorial peer 
review, and will be reflected in judging the appropriateness of articles for the journal. Our 
guiding values include: 

  The highest standards of ethics in research 
  Innovation and exploration 
  Sound research methods and designs 
  Scholarly and accessible non-technical language 
  Cross-(multi)-disciplinary methods and implications 
  Professional and personal practitioner development 
  Respect for ecosystems including planetary, local environments, families, 

relationships and social systems 
  Cultural diversity, safety and healing/reconciliation 
  Mentoring and life-long learning 
  Holistic and integrative approaches 
  Equity in research  
  Support of minority issues 

Although CPH Journal cannot guarantee submissions will be recommended for 
publication we endeavor as far as possible to assist authors to improve themselves and 
their texts. The goal of this approach is to help authors develop their ideas by working 
collaboratively with reviewers’ comments, which will aim to assist authors to bring out the 
best in their work. The qualities of the editorial relationship that we support include 
encouragement, respect and collaboration. 
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Types of Articles Accepted 
 
Articles accepted for CPH Journal fall into the following categories: 
 

1. Original research in counselling and/or psychotherapy, and the use of 
counselling and/or psychotherapy in allied health fields; 

 
2. Original research in allied health that addresses implications for counselling 

and/or psychotherapy practice, training, policy, or professional discourse; 
 

3. Original research addressing some aspect of the Guiding Values of CPH Journal; 
 

4. Case studies, where ethical methods of data collection have been applied; 
 

5. Critical discussions, reviews, and debates regarding the relevance to practice of 
existing research studies; 

 
6. Papers that address conceptual issues related to practice in counselling and/or 

psychotherapy directly, or those that are related to the use of counselling and/or 
psychotherapy in allied health fields (i.e. philosophical, theoretical, political, 
sociological, historical, structural, critical); 

 
7. Studies related to the cultural, historical, and social contexts of emerging 

practices; 
 

8. Papers that address methodological, moral, and/or ethical issues impacting on 
the practice of counselling, psychotherapy, and health. 

 
Requirements for Copy 
 

1. Copy must be accessible and readable, and will present in a simple, clear, 
grammatically sound and direct style of English. As CPH Journal is published 
open-access to both public and professional readerships, articles must reflect a 
non-technical and non-jargon language, and include a small table of technical 
terms where these cannot be avoided. Articles must inspire readers to continue 
reading, and so need to be both scholarly and of human interest. 

 
2. Copy will comply with non-discriminatory and non-sexist language conventions. 

 
3. Copy will be typed, single spaced, left justified only, all 12-point font size 

including headings, and saved as an electronic file in Microsoft Word or rich text 
format (rtf) only. 

 
4. The body of the article will include a header or footer on every page with the title 

of the manuscript and the date of submission, with page numbers on every page. 
The body of the article must not include any identifying details of the author(s). 

 
5. The author(s) will need to download and fill in the form ‘Author Submission 

Form’ and submit this form in addition to the file containing their article as 
described above. The form will be used to record author(s) details and the 
administration of the review process from start to finish. 
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6. All articles (regardless of their focus or format) will contain an abstract describing 
the content of the article. Abstracts will be 150 words or less. 

 
7. All tables and figures should be numbered and presented on the top of a new 

page in the text where they appear. Illustrations originated by the author(s) are 
accepted as digital reproductions only in jpg format. 

 
8. Written permission from copyright holders must be obtained by the author for any 

illustration, table, or quote of more than 100 words published elsewhere.  
 

9. Articles may be between 800 to 10,000 words in length. Where an article is of 
exceptional merit, up to 15,000 words may be considered.  

 
10. For articles that exceed 15,000 words, the article must report an original and 

major research study (defined as a study that exceeds two years in duration). 
The author(s) are asked to write directly to the Editor in Chief with a maximum 
800 word proposal/letter detailing the reason why they wish to submit a lengthy 
article, and how this will benefit the readership of CPH Journal. 

 
Referencing 
 
Articles submitted to CPH Journal will use the (Author/Date) system, also known as the 
Harvard System of referencing, or the American Psychological Association (APA) 
format. An example follows. 
 
The following Harvard excerpts are taken from: 
 
Bowers, R. & Minichiello, V. (2001) A review of homosexuality: Changes over time. In 
Wood, C. (Ed), Sexual Positions: An Australian view, Hill of Content, Melbourne, 131-
155. 

 
Even while taking a balanced view of his social context, Freud’s writings 
reveal what is now considered bias and prejudice.  For example, he 
believed that women were more primitive than men, and that they had a 
‘greater proneness... to neuroses and especially to hysteria’ (in Friedman, 
1998:250). His theory of female development supported these claims 
(Freud:1933). He believed that the Oedipus complex was biologically 
determined and universal (Freud: 1924; Freud: 1940). In Freud's view, 
failure to resolve this developmental challenge led to psychopathology. Had 
Freud had the concept of homophobia, this conclusion would have been 
totally different.  The end result was that his theory led to reinforcing the 
pathologising of a misunderstood experience. 
 
‘As a society,’ says Silverstein, (1991:103), ‘we train people to suffer. We 
decide which behaviors are acceptable, we tell people they are deviant, we 
stigmatize and oppress them, and when they come to us unhappy about 
themselves, we tell them to get treatment.’ No one can argue that 
counselling happens within socio-historical contexts. It may also be 
assumed that the views and values of counsellors are shaped by their 
social upbringing and reshaped or reinforced by their education. 
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Harvard References: 
 
Freud, S. (1924) The dissolution of the Oedipus complex. Standard Edition, 19, 73-79. 
 
Freud, S. (1933) Femininity. Standard Edition, 22, 112-135. 
 
Freud, S. (1940) An outline of psychoanalysis. Standard Edition, 23, 144-207. 
 
Friedman, R. and Downey, J. (1998) ‘Psychoanalysis and the model of homosexuality as 
psychopathology: A historical overview’ The American Journal of Psychoanalysis, 58(3), 
249-270. 
 
Silverstein, C. (1991) ‘Psychological and medical treatments of homosexuality’ in 
Homosexuality: Research implications for public policy, (Eds), Gonsiorek J and 
Weinrich, J, Sage, London. 
 
Procedures to Submit 
 

1. Prepare the manuscript as described above; 
 
2. Save the file in Microsoft Word or Rich Text Format (rtf) – a function of MS Word 

and most other major word processing packages, including WordPerfect, 
AbiWord, OpenOffice and so forth; 

 
3. Download and fill in the form ‘Author Submission Record CPH Journal’; 

 
4. Open your email window, and put in the subject heading ‘Re: Article for CPH 

Journal’; 
 

5. Attach the two files to the email (manuscript and administrative form); 
 

6. Send your email to "ACA" aca@theaca.net.au with “CPH Journal Submission” in 
the header; 

 
Copyright Agreement 
 

1. The Author (understood to mean the Principle Author whose sole responsibility it 
is to properly administer this agreement on behalf of any and all co-authors) 
hereby assigns to CPH Journal (hereafter known as the Publisher) the copyright 
to the Contribution named above; whereby the Publisher shall have the exclusive 
international rights to publish in any and all media the said Contribution and 
translations of it wholly or in part throughout the World under the provisions of 
this agreement. These rights include without limitation mechanical, electronic and 
visual reproduction; electronic storage and retrieval; and all other forms of 
electronic publication or any other types of publication including all subsidiary 
rights. 

 
2. Any and all publication by the Publisher of author’s work in any form or media is 

agreed by the author to be undertaken without regard for notification or 
permission by the author, and at the sole discretion of the Publisher.  
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3. All publishing rights consigned to the Publisher continue indefinitely, however, 
after no less than three years from the date of first publication by the Publisher 
authors may continue to publish their work in any form or media under the 
following terms and conditions. 

 
4. Authors agree to not publish their submission in any form for a period of at least 

three years from the date of first publication in the Journal, after which authors 
are free to publish submitted material with an acknowledgement reading, ‘This 
article was first published in Counselling, Psychotherapy, and Health, Vol [ ], 
Issue [ ].’ This acknowledgement can be attached to the end of the author’s 
subsequent publication of the work, and under these conditions no notification to 
the Journal is necessary. 

 
5. Prior to publication, authors are asked to certify that their work is submitted only 

to the Publisher and has never been published before under any form.  
 

6. The Author guarantees that the Contribution is original, has not been published 
previously, is not under consideration for publication elsewhere, has been 
properly acknowledged and/or referenced, and that any necessary permission to 
quote from another source has been obtained. (A copy of such permission 
should be sent with this form if applicable.) 

 
7. The Author declares that any person named as co-author of the Contribution is 

aware of the fact and has agreed to being so named, and has made a 
substantive contribution to the work. 

 
8. Any and all co-authors are bound by the same agreement 

 
The Review Process 
 
No submissions are rejected after one review. A minimum of two reviews of an article 
occur before CPH Journal elects to reject a submission. Our intention is twofold. On one 
hand, we intend to publish only high quality work that upholds professional standards. 
On the other hand, we hold firm to values of mentoring and encouraging of authors, and 
open debate on issues regardless if they conflict with our opinions. Therefore, our 
publication does not gain its merit by rejection rates. Rather, we see our role as 
extending the window of opportunity for author’s work to be considered for publication. 

>From time to time, changes to editorial policy and procedure are necessary to attend to 
quality improvements. If such changes influence existing articles under review, authors 
will be appropriately notified. 

The possible outcomes of the review process are: 

(i) Minor revisions with recommendation to publish; 
(ii) Major revisions with recommendation to improve the draft towards publishing 

via submitting the revised draft for a second review based on adherence to 
prior suggestions; 

(iii) Extensive revisions with recommendation to improve the draft without 
recommendation to publish at this stage of manuscript development via 
considering gaining the assistance of a senior academic mentor;  

(iv) Extensive revisions without recommendation to publish; or 
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(v) The rejection of the manuscript, after the protocol above has been 
addressed. 

Resubmission of Rejected Manuscripts 
 
In cases where manuscripts are rejected after going through the above protocol, authors 
may elect to resubmit extensive revisions of previously rejected work up to a maximum 
eighteen months from the date of the rejection of the manuscript. The author will provide 
copies of all prior drafts, and documentation to the Editor-in-Chief. Authors are also 
asked to send a cover letter documenting their reasons for asking the Journal to 
reconsider the manuscript and how they have met the expectations from prior reviews. 
The Editor-in-Chief will consider the request. Based on the Editor’s discretion, they will 
either reject the request with written justification of their rationale to the author, or they 
will elect a review of the piece. In either case, the Editor’s decision is final. The results of 
a possible review will also be final, and will only consist of either (i) acceptance, or (ii) 
rejection, with no recourse for anything but minor revisions. Authors should keep in mind 
that the timeline involved in revision may be a factor in publication, and that long-delayed 
revisions should incorporate literature that appears in the intervening time so as to 
maximize the currency of the article. 
 
Editing of Manuscripts 
 
Once a manuscript is received at administration, the Microsoft Word or rich text format 
(rtf) file containing the manuscript is opened. The table below is inserted. An 
administrative code is inserted to assist in tracking the manuscript through the review 
process. We include this information so that authors are informed about the questions 
reviewers will consider while evaluating the manuscript. 
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Dear Author: 
This table is inserted into your article submitted to CPH Journal. All editing will be tracked 
in this file. For the review process to proceed smoothly, author(s) must be prepared to 
receive critical and supportive comments about their work.  Indeed, constructive criticism 
itself is one of the most supportive and most important parts of the review process.  On the 
other hand, reviewers endeavour to make their comments supportive, constructive, 
informative, and mentoring. You will understand that reviewers must be free to assess and 
to discuss the weaknesses and strengths of the article. While we acknowledge the 
challenging parts of the review process for authors, we also appreciate your openness to 
receiving whatever comments come forward from reviewers.  Thank you again for 
submitting your article to CPH Journal.   – The Editor in Chief 

Article No: 

Date of Submission:  

Title:  

Editor/Associate Editor 
overseeing review 
process: 

 

Reviewer’s Summary (comments will appear throughout the manuscript) 
1: Briefly highlight three positive aspects and/or strengths of this article. (The box will expand as 
you type). 
 
2: Briefly highlight three negative aspects and/or weaknesses of this article. 
 
3: Does this article address and/or reflect in some way one or more of our Guiding Values listed 
below? Delete either yes or no, leaving your answer here: Yes   No 
 
BOLD the values highlighted below:  

  The highest standards of ethics in research 
  Innovation and exploration  
  Sound research methods and designs 
  Scholarly and accessible non-technical language 
  Cross-(multi)-disciplinary methods and implications 
  Professional and personal practitioner development 
  Respect for ecosystems including planetary, local environments, families, relationships 

and social systems 
  Cultural diversity, safety and healing/reconciliation 
  Mentoring and life-long learning 
  Holistic and integrative approaches 
  Equity in research  
  Support of minority issues 

4: What is your overall recommendation regarding this article? Please BOLD YOUR ANSWER: 
 
(1) Minor revisions with recommendation to publish  
(2) Major revisions with recommendation to improve the draft towards publishing via submitting the revised 

draft for a second review based on adherence to prior suggestions.  
(3) Extensive revisions with recommendation to improve the draft without recommendation to publish at this 

stage of manuscript development via considering gaining the assistance of a senior academic mentor  
(4) Extensive revisions without recommendation to publish  
(5) The rejection of the manuscript, after the protocol above has been addressed. 
Comment (if applicable): 
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Editing Using Track Changes 
 
Although we attempt to use the current word processing technology in our review 
process, technology is every changing so you may elect to type traditional review 
comments.  
 
In your returned manuscript you may find two types of feedback. One type that you may 
see includes edits and/or suggestions for grammar, academic style corrections for 
compliance, spelling changes, etc. The second thing you will notice is balloons in the 
margins (or comments in a pane at the bottom of your screen) of your paper that contain 
the locations and suggestions for clarification, expanded explanations, and additions to 
what you have written. 
 
We are including the software steps you can take to view and make the changes to your 
paper that will allow us to track the entire sequence upon resubmission. Please use this 
document to continue working if possible. Then return this document to us with all of 
your changes, and the string of comments for our review. 
 
Using Microsoft Word to Edit and Review Manuscripts 
 
The following are the steps you will use to edit and review the papers you receive as 
Manuscript Consultants: 
 

1. Click on the View menu and click on the Print Layout tab. This will enable you to 
view the changes you make in the manuscript. 

 
2. Click on the View menu and click on Tool Bar tab and then click the Reviewing 

tab so that the Reviewing option is selected. This will enable you to use the Track 
Changes and Insert Comments tools with the manuscript. 

 
3. Click on the Tools menu, click Options, and then click the User Information tab. 

In the Name and Initials boxes, type the name and initials you want to use in the 
changes and comments you make in the manuscript.  

 
4. To begin to track the changes you make as you edit the manuscript, move your 

cursor to the Reviewing toolbar and click on the Track Changes icon. The Track 
Changes icon appears as a white document page with red lines with a bright star 
or asterisk on the upper right hand corner and yellow pencil located at the lower 
right hand side. When the Track Changes feature is turned on, you will notice the 
TRK letters in the box at the bottom of the computer screen appear in a black 
colored font. Once this option is turned on, every deletion, insertion, and 
correction you make to the manuscript will be recorded. This will allow you to 
create an audit trail for the editors and authors to read and review. 

 
5. To turn off the Track Changes feature, move your cursor to the Reviewing toolbar 

and click on the Track Changes icon again. When the Track Changes feature is 
turned off, you will notice the TRK letters in the box at the bottom of the computer 
screen no longer appear in the black colored font. With the Track Changes 
feature turned off, you can then delete changes that had been made in the 
manuscript by using the Delete or the Backspace key. 
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6. To insert a new Comment, place the cursor on the position in the manuscript to 
which the Comment is being directed, then click on the Insert Comment icon 
located on the Reviewing Tool Bar. The Insert Comment icon is a picture of a 
yellow folder with a bright star or asterisk on the upper right hand corner of the 
yellow folder. Depending on the version of Word you have, you will have the 
option of writing your comment in a Comment balloon that appears in the right 
hand margin of the manuscript or in the Comments windowpane that appears at 
the bottom on the computer screen. In some versions of Word, you can use both 
display options. 

 
7. To delete a Comment of your own, you can place your cursor on the Comment in 

the text or on the Comment balloon located in the right hand margin, then click 
the right button on your mouse and then click on the Delete Comment tab. In 
older versions of Word, the Comment will appear as a portion of text highlighted 
in yellow. You can also place your cursor on the Comment in the text or on the 
Comment balloon located in the right hand margin you wish to delete and then 
move your cursor on the Delete Comment icon located on the Reviewing Tool 
Bar and then click the left button of your mouse to delete the Comment. The 
Delete Comment icon is a picture of a yellow folder with a red X located on the 
upper right hand corner of the yellow folder. Please note that the Delete 
Comment icon can only be used if you have placed your cursor on the Comment 
you wish to delete. 

 
8. To edit a Comment of your own, you can place your cursor on the Comment in 

the text, then click the right button on your mouse and then click on the Edit 
Comment tab. You can also place your cursor on the Comment in the text you 
wish to edit and then move your cursor on the Edit Comment icon located on the 
Reviewing Tool Bar. The Edit Comment icon is a picture of a yellow folder with a 
yellow pencil located on the middle of the yellow folder.  Once you have clicked 
either the Edit Comment icon with the left button of your mouse or the Edit 
Comment tab with the right button of the mouse, the Comment windowpane will 
open at the bottom of the screen. Move the cursor to the Comment windowpane 
and click the left mouse button on the Comment you wish to edit. You can then 
begin to edit the Comment. If you are using a version of Word that has the 
Comment Balloon option, place your cursor on the Comment balloon located in 
the right hand margin you wish to edit and click the left mouse button. You can 
then begin making your edit. Depending on your version of Word, you can edit 
the Comment in the Comment balloon or in the Comment windowpane. Please 
note that the Edit Comment icon can only be used if you have placed your cursor 
on the Comment you wish to edit. 

 
9. To receive additional help or pointers with using these Microsoft Word editing 

and reviewing features, please access Word’s Help resource or email one of the 
Editors for further assistance. 

 
Publishing 
 
Upon offer to publish, author(s) will be required to sign an agreement for publication, 
which will be completed and faxed to administration. This agreement will include 
copyright components, author permission and indemnity clauses relevant to publication 
with CPH Journal. Before the publication of the article, author(s) will receive proofs for 
checking. At this point, no substantial changes can be made.  
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Notes 
 
CPH Journal wishes to gratefully acknowledge the following sources which assisted in 
developing these guidelines. These resources were accessed during September 2004. 
 
Counselling and Psychotherapy Research, Instructions for Authors, 

http://cpr.bacp.co.uk/authors.html  
 
Counselling Australia, Contributor’s Guide, internal publication. 
 
Journal of Integrative Psychology, Submitting Articles, 

http://www.integrativepsychology.org/submit.html 
 
The Qualitative Report, Using Microsoft Word to Edit and Review Manuscripts copied 

with permission, internal publication. We gratefully acknowledge that the inspiration 
for our mentoring approach came from TQR and their innovative vision. 
http://www.nova.edu/ssss/QR  

 
University of New England, Academic Skills Office, Teaching and Learning Centre, 

The Author-date System, http://www.une.edu.au/aso/referencing_style_guide.htm  
 


